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ABOUT THIS DOCUMENT 

• This Handout is the repository for supplemental information and personal recommendations 

provided by the Special Interest Group (SIG) Facilitator for use by the Genealogical Forum of Oregon 

(GFO) RootsMagic SIG members. There may be errors in this Handout and some information may 

conflict with how the reader has decided to use the program. Therefore, you use the information in 

this Handout at your own risk.  

• This Handout is intended to be used in conjunction with the RootsMagic Online Help, accessible 

from within the RootsMagic program using the F1 key, from the HOME Page and by selecting Help in 

the Options Menu found in the upper right corner of the program window.  

• This is a living document that is periodically updated as new sections are discussed in the monthly 

SIG meetings, the software changes, the Online Help changes and/or new information about how 

the existing version of the program works (or doesn’t). Very little information found in the Online 

Help is repeated in this Handout. When information included in this document is incorporated in the 

Online Help, it will be deleted from this Handout. Currently, this document covers information for 

RootsMagic versions 9 and 10. 

• The latest version of this document can be found at the GFO RootsMagic SIG webpage:  

https://gfo.org/learn/special-interest-groups/rootsmagic.html.  

Barry Wolff - GFO RootsMagic SIG Facilitator – RootsMagic@gfo.org 

GENERAL 

1. RootsMagic does not provide telephone support. Any information you find online about phone 

support is a scam 

2. RootsMagic Help is available via several means, all accessible from the HOME Page: 

a. Online Help (F1 key) takes you to: 

i. v9 Help: https://help.rootsmagic.com/RM9/index.html 

ii. v10 Help:  https://help.rootsmagic.com/RM10/index.html 

b. Technical Support  

i. Online Chat (M-F during normal work hours, Mountain time) 

ii. Online Help Request submittal 

c. RootsMagic Online Community 

3. Help is also available via the FaceBook RootsMagic Users Group (private group, administered by 

RootsMagic) 

4. If you are new to RootsMagic, in addition to the Online Help, you may find the “Getting Started 

with RootsMagic 9” and “What’s new in RootsMagic 10” YouTube videos produced by 

RootsMagic helpful in learning the basics and newest features: 

a. https://www.youtube.com/watch?v=kjfXNymgNN0 
b. https://www.youtube.com/watch?v=W-3T8rWwwEI  

5. If the RootsMagic program “freezes” and nothing appears to work for some reason, but other 

programs continue to work as normal on your computer, you need to terminate the RootsMagic 

program, which can be done as follows: 

a. For Window PCs: 

i. Press Ctrl, Alt & Delete keys at the same time 

ii. Select Task Manager 

https://gfo.org/learn/special-interest-groups/rootsmagic.html
https://help.rootsmagic.com/RM10/index.html
https://www.youtube.com/watch?v=kjfXNymgNN0
https://www.youtube.com/watch?v=W-3T8rWwwEI
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iii. On the Processes Tab, locate the program and select it 

iv. At the bottom right, click on “End Task” to terminate the program 

v. Close Task Manger 

vi. Restart RootsMagic 

b. For Macs: 

i. Press Option, Command & Escape at the same time to open Force Quit, or select it from 

the menu 

ii. Locate the program and select it 

iii. Force Quit the program 

iv. Close Force Quit 

v. Restart RootsMagic 

6. If you move a RootsMagic database file between Mac and Windows computers, the first thing 

you should do after opening the file is to run the Tools > Database Tools > Rebuild Indexes 

function. 

THE ROOTSMAGIC INTERFACE 

https://help.rootsmagic.com/RM9/the-rootsmagic-interface.html 

https://help.rootsmagic.com/RM10/the-rootsmagic-interface.html  

PEOPLE PAGE 

1. Searching from the PEOPLE Page Index and/or People List View: 

a. General search format is Surname, Given Name 

b. Anything entered prior to a comma is considered a Surname search phrase and anything 

entered after a comma is considered a Given Name search phrase 

c. Partial names can be entered, and it does not have to start with the first letter 

d. Given Names can be searched without entering anything prior to the comma 

e. The search will commence and refine the results as characters are entered in the search box 

f. Wildcard characters can be used in PEOPLE Page Searches: 

i. Single character wildcard = “_” 

ii. Any number of characters, including zero, wildcard = “%” 

g. If you start your surname search with a double quote (“), search results will only include 

surnames that start with the letters entered. This special character does not work for given 

name searches (letters entered after a comma). 

h. Searches on the Couple List View will include Married Surname results.  

i. In v10, you can search for either, or both, Father and Mother names by using an ampersand 

“&.” Anything entered before the symbol is applied to the first column (Father) and anything 

entered after is applied to the 2nd column (Mother).  

j. If known, you can also enter the RIN (record ID number) for a specific person. 

2. Association View: 

a. Associations allow you to define a non-family relationship between 2 people in your 

database. 

i. Both people must be entered in the database file 

ii. Unlike Facts, Associations cannot be shared with other people. 

https://help.rootsmagic.com/RM9/the-rootsmagic-interface.html
https://help.rootsmagic.com/RM10/the-rootsmagic-interface.html
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iii. There are 16 built-in Association Types, which cannot be deleted. You cannot edit the 

name or the names of Role 1 & Role 2 for the built-in Association Types. 

b. Creating an Association between two people in separate trees within the database file DOES 

NOT “connect” the trees together into a single tree.  

c. Adding an Association: 

i. There are five ways to add an Association to a person: 

1. Click on the +(Add) icon to add a Fact, and then select “Association” 

2. Hover over a person, right click and select “Add Association” 

3. Open the Command Palette and select “Add Association” 

4. From the person’s Edit Person window: 

a. Click on the +(Add) icon to add a Fact, then select “Association” 

b. Hover over the Fact list area, right-click and select “Add New Fact”, then select 

“Association” 

ii. Then select the Association Type and fill in the rest of the data fields 

iii. If you enter data in the Note field, it will be appended to both people’s sentences, if 

Notes are included in the report settings 

d. Association Sentence Templates cannot be customized for individual Associations 

e. To view each Associate’s resulting sentence from their Sentence Template, you must view 

the Association from each person’s Edit Person window 

3. Association Types: 

a. Association Types can be created and edited in a manner similar to Fact Types by opening 

the Association Type list. 

b. Unlike Fact Types, there are no Association Type settings to select which outputs to include 

them in. Instead, the inclusion of Associations is made in the “Report Settings” section for 

each applicable report.  

SEARCH PAGE 

1. The columns of information shown in the People and Advanced People search results are the 

ones selected to Customize the People List View on the PEOPLE Page 

2. Person Search View:  

a. Partial names can be entered, and it does not have to start with the first letter 

b. Wildcards and the double quote (“) character DO NOT work for name searches 

3. Advanced People Search: 

a. Some have reported that RM is “slow” after performing an Advanced Search as long as the 

filtered results are present in the Results area of the SEARCH Page. It is recommended that 

once you are finished working with the results, that you click on the Clear Results button. 

b. Wildcards and the double quote (“) character DO NOT work for name searches 

c. The following table contains all the data fields that can be used for Advanced People 

Searches based on Criteria and all other functions that utilize the Boolean Logic/Criteria 

filter window:

Each Fact in the database                       Note (general) 

Associations Number of children 

Any Fact                                                      Number of sets of parents 



GFO RootsMagic SIG Handout 

Barry’s Recommendations/Online Help Supplement 

Page 4 of 43   7 July 2025 

Color Coding                                              Number of siblings 

Current Age                                                Number of spouses 

Date Edited                                                 Prefix 

FamilySearch ID                                         Record number 

Given name(s)                                     Sex 

Given or Nickname                                    Source (family) 

Living flag                                                    Source (general) 

Married Surname                                       Suffix 

Nickname Surname 

Note (family)                                               Surname (Birth or Marr) 

4. Web Search: 

a. The list of people in the database can be searched, similar to the PEOPLE Page Index, using 

the format of: Surname, comma, First Name. 

b. Partial names can be used too 

c. Wildcards and the double quote (“) character work for name searches 

TOOLS PAGE 

1. For each tool with a red “Important” warning, you should perform a database Backup prior to 

using the tool in case the results are not as expected. 

SETTINGS PAGE 

1. The Settings Views: 

a. Program Level settings are set in:  Program, Folder, & Display Views 

b. File Level settings are set in:  General, Preparer, WebHint and LDS Views 

2. Program Settings View: 

a. Ask for Backup when exiting RM – YES 

b. Add date to backup – YES 

c. Check for duplicates when adding people – YES 

d. County Check – YES (unless you always use current day locations) 

e. Date entry – USE SYSTEM SETTINGS 

3. Folder Settings View: 

a. Data Folder – This location should be set prior to using TreeShare with Ancestry or Restoring 

a Backup. This will enable RM to use “relative” paths for media files placed in the resulting 

media folders when performing these activities. Otherwise, RootsMagic will store “discrete” 

paths for media file links. 

b. Backup Folder – Set to its own folder location to keep backup files separate from all other 

file types 

c. Media Folder – Starting with RootsMagic 8, media files are linked using “relative” paths from 

several locations (despite displaying full path names, including drive letter, to the user; 

implying all links are “discrete”).  

i. All media files added after a Media Folder location is specified in the Folder Settings 

View on the SETTINGS Page will be “relative” to the Media Folder location, if the media 
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file is located in the folder or a subfolder. Therefore, it is recommended that the Media 

Folder specified should be the “top level” folder where most/all media files being added 

are located, or in sub-folders. Ideally, the Media Folder location should be specified 

prior to linking any media files to information in the RM database file. 

ii. Changing the Media Folder location after already having linked media files will result in 

broken links that must be fixed after the change using the “Fix Broken Links” tool 

(TOOLS Page). 

d. Help Folder – Leave blank to ensure you always view the latest Help information available 

online unless you have a unique circumstance where internet access is limited. 

4. General Settings View: 

a. Database Color – Recommend selecting a different color for each of your database 

files/groups of files, especially if you work with more than 1 open at a time. Remember you 

must switch Pages to reflect the newly selected color. 

b. Problem Alerts – YES 

c. Problem Options – Review to make sure they meet your expectations for Alerts 

5. Display Settings View: 

a. Font scaling – Remember to close RootsMagic and re-open to ensure all fonts are set to the 

new settings. Also, take note of the setting prior to making a change so that you can reset it 

if you decide you don’t like the new setting 

6. Preparer Settings View:  

a. Name, Address, Phone and E-Mail are the only entries that will be included in reports when 

Preparer Data is selected to be included. Cell, Fax and Website entries are not used in 

reports. 

7. WebHint Settings View: 

a. Ancestry: 

i. For Ancestry Hints to work, you must be logged in and linked to a tree via RootsMagic 

Treeshare 

ii. The “Clear on Accept” setting controls how TreeShare works, not WebHints. When 

selected and the “Only Show Changed People box is selected in the TreeShare window, 

after the highlighted Person’s changes are accepted in TreeShare, the Person is removed 

from the list of People displayed and the highlighted person is the first person in the list 

1. It is recommended that this combination of settings only be used when you work 

the TreeShare list from top to bottom to avoid having to scroll through the list to 

find where you were after each set of changes are accepted.  

iii. Warning: DO NOT select “Disconnect from Ancestry Tree” unless you really want to 

permanently sever the Treeshare link between the Ancestry Tree and your RM file. THIS 

ACTION CANNOT BE UNDONE. If done in error, a recent Backup file from when 

Treeshare was still connecting to your tree must be restored, or a new Treeshare 

connection must be created with either a new Ancestry Tree or a new RM file. (You 

cannot “re-connect an existing Ancestry Tree to an existing RM database file). 

iv. Rather than “Disconnect from Ancestry Tree”, use the “Reset Treeshare” function to 

force RM to rebuild the links between the connected Ancestry Tree and RM database 

file. 

b. FamilySearch: 
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i. For FamilySearch Hints to work, you must be logged into FamilySearch  

ii. For FamilySearch, hints are provided for people regardless of whether you have 

matched them to their corresponding person in the FamilySearch Family Tree  

c. FindMyPast: 

i. Evaluating and dispositioning FindMyPast Hints is a completely manual process 

performed external to RootsMagic. Data from any Confirmed Hints must be manually 

entered into RootsMagic. 

d. MyHeritage: 

i. Evaluating and dispositioning MyHeritage Hints is a completely manual process 

performed external to RootsMagic. Data from any Confirmed Hints must be manually 

entered into RootsMagic. 

8. LDS Settings View:  

a. No recommendations 
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DATABASES 

https://help.rootsmagic.com/RM9/databases.html 

https://help.rootsmagic.com/RM10/databases.html 

GENERAL FILE INFORMATION : 

1. The database engine used by RootsMagic is SQLite ( www.sqlite.org ). SQLite does not support 

multiple users. Therefore, it is important to only have one computer, with one computer 

program, accessing the database file at a time 

2. RM Tech Support recommends not using ANY file syncing/sharing programs on your RootsMagic 

database file as it can cause database access errors and, worst case, there is the possibility that 

it can corrupt the file, making it unrecoverable. This recommendation is just for the database file 

itself and does not apply to media, backups, or any other type of file that RM uses/creates. They 

are aware of situations where people have used file syncing/sharing for extended periods of 

time with no issues and then one day their database file becomes corrupted and is 

unrecoverable.  

3. When strange things occur that may be the result of a corrupted database file, the following 2 

steps should be tried to see if either will fix the issue: 

a. Run all of the Database Tools prior to reaching out for help: FILE Page > Tools (also found on 

TOOLS Page). Then perform each of the Database Tools (Test Integrity, Rebuild Indexes, 

Clean Phantom Records and Compact), the order is not important. 

b. If running the database tools does not fix the issue with the database, the next step is to 

Drag & Drop the entire database contents into a new, empty, file. Don’t delete the original 

file because you may need to reference it to manually migrate data that did not transfer 

(see end of this section) 

4. File extensions: 

a. ADP & ADP-journal– Interim files created by RootsMagic when the TreeShare window is 

open. File is normally deleted by the program when the TreeShare window is closed. It is left 

behind when RootsMagic encounters a problem or the process is cancelled while the 

TreeShare window is open. These file types can be deleted.  

b. docx – Microsoft Word file (PUBLISH Page output format) 

c. DUP & DUP-journal – Interim files created by RootsMagic when identifying duplicate entries 

and/or file compare. File is normally deleted by the program when complete. It is left behind 

when the program encounters a problem or the process was cancelled. These file types can 

be deleted 

d. ged – GEDCOM file (used to transfer data between genealogy sites/software) 

e. lst – RM list file (text file created when a GEDCOM file is imported into RootsMagic. It will 

list any issues encountered during the import process) 

f. pdf – Adobe portable document format file (PUBLISH Page output format) 

g. rmbackup – v8, v9 or v10 backup file (compressed .zip file) 

h. rmgb – RM7 backup file (compressed .zip file) 

i. rmgc – RM7 database file (also RM8 file exported to Dropbox for use by RM IOS App) 

j. rmtree – v8, v9 or v10 database file 

https://help.rootsmagic.com/RM9/databases.html
http://www.sqlite.org/
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k. rmtree-journal - Interim journal file created by RootsMagic. File is normally created & 

quickly deleted multiple times while performing tasks that require progressing through a lot 

of data in the file, such as TreeShare and Building Thumbnails. If left behind due to a task 

not running to completion, it may prevent follow-on RootsMagic tasks from running error 

free. This file type should be deleted. 

l. rmst – RM Custom Source Template file (Custom Source templates can be 

imported/exported from the Source Template List window)  

m. svg – Scalable vector graphic file ((PUBLISH Page output format) 

n. txt – Text file (PUBLISH Page output format) 

o. xlsx – Miscrosoft Excel file (PUBLISH Page output format) 

5. A database file deleted from within RootsMagic IS NOT placed in the Recycle Bin/Trash Can, it 

just permanently disappears.  

a. Before deleting, archive (using RM Backup, with media if desired) a copy if you believe you 

may want to resurrect/use the file in the future. 

6. Importing post-2014 Family Tree Maker (FTM) data to RootsMagic cannot be done directly due 

to FTM’s proprietary file format. RM Tech Support recommends trying all of the following and 

evaluate which process works best with your specific set of data: 

a. Sync FTM data to an Ancestry Tree and then download Ancestry Tree data (including media) 

to RM via Treeshare function 

b. Export FTM data to a GEDCOM file and import into RM 

c. Export FTM data to FTM v2014.0 or earlier and import into RM (Per RM Tech Support, the 

RM7 import FTM 2014 tool works better than the current v9 FTM 2014 import tool, this will 

be fixed in a future update) 

d. As you evaluate the results of the above options, in addition to looking at the file properties 

on the HOME Page and Enhanced Property List on the TOOLS Page, you may want to use the 

File Compare function to help identify differences between the imported files. 

7. Direct import of Legacy data to RootsMagic can only be accomplished with the 32-bit version of 

RootsMagic installed on a Windows PC (v7 & 8 are 32-bit and v9 & v10 are available in both 32- 

& 64-bit versions). 

CREATING A NEW DATABASE: 

1. Before creating a new RootsMagic file, it is recommended that you first go to the Folder Settings 

View on the SETTINGS Page and specify at least the Data and Media folder locations because 

these are used by RootsMagic to determine whether “relative” or “discrete” path locations will 

be placed in the database to identify link paths to database and media files.  

2. Create New, Empty, File: 

a. After creating a new file, do the following: 

i. Go to the SETTINGS Page and review all the File specific settings in the General, 

Preparer, WebHints & LDS Views 

3. Create New File by Importing Data or Downloading from an Online Tree: 

a. If importing data from a GEDCOM file exported from a RootsMagic file to create a new file, 

all limitations and cautions regarding using GEDCOM to exchange RootsMagic data (see end 

of this section) apply. 
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b. After creating new file by importing data or downloading from an Online Tree, do the 

following 

i. Go to HOME Page and review the File Properties to confirm what you expected was 

imported 

ii. Just like creating a new, empty file, go to the SETTINGS Page and review all the File 

specific settings in the General, Preparer, WebHints & LDS Views 

iii. Be aware that imported/downloaded data may result in: 

(1) New Custom Facts created for Fact Types that do not match existing RootsMagic 

Fact Types 

(2) Sources and Citations created using the Free Form Template, rather than your 

preferred Source Template type. 

(3) Place names and Place Details that do not conform to your naming and/or structure 

conventions. 

iv. Depending on your intended use of this new file, you may need to clean up the 

imported/downloaded information to meet your standards/conventions. 

c. Consider “Archiving” a copy of the original file that was imported and a copy of the file after 

it was imported for future reference in case you need to determine whether some 

erroneous information originated in the original import, or was added later using RM. It can 

also help you figure out if data was “lost” during the import process that you didn’t notice 

until later. 

OPENING AN EXISTING DATABASE: 

1. The “Recent Files” section lists up to the last 8 files opened 

2. The “Found Files” section only lists files found in the folder and subfolders specified in the 

SETTINGS Page, Folders Settings View for the “Data Folder”. The list will contain both RM8 to 10 

(.rmtree) and RM7 (rmgc) files.  

a. If looking for a “missing file” you are better off using the operating system File 

Explorer/Search utilities and wildcard characters to try to locate where the file is located. 

WORKING WITH MULTIPLE DATABASES 

1. Up to 4 different files can be open at the same time (only 1 in the free version). 

a. If you want to view information for different parts of your database, other than individual 

Person Edit screens; you must make a copy of your database file and assign a different name 

to it. Make sure you only make changes in your original file, not the copy. I recommend 

giving it a unique Database Color Assignment that reminds you that it’s not your master file 

for making changes (SETTINGS Page > General Settings View). 

2. If you have RootsMagic set to open the last file used, when working with multiple databases, 

close the database you believe you will want to use next time, last. 

3. The 1st file opened behaves a little different compared to the 2nd to 4th files: 

a. When the 1st file is minimized, all open file windows are minimized 

b. As long as the 1st file is not minimized, the 2nd to 4th files can be minimized and they are 

placed in the lower left of the desktop 
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c. If you close the 1st file before any of the other open files, the behavior of the 1st open file 

transfers to the next file opened in the session that remains open 

d. Currently, there are a few popup windows that appear centered in the 1st file window, even 

if you are working in the 2nd to 4th file.  Therefore, it is advised to NOT position the 1st file 

window so that the center of the window is not in the visible Desktop area. If you do, the 

Program appears to “freeze” because you cannot see/click the buttons on the Popup 

window, requiring the user to have to terminate the Program execution. 

e. Popups I have identified (so far) that center on the 1st file window are: 

i. The Spouse selection popup window when creating a Couple Fact (Marriage, Divorce, 

etc) 

ii. The WebHint list for a Person 

DRAGGING AND DROPPING PEOPLE 

1. Drag & Drop data transfer limitations: 

a. If the Drag & Drop data contains Source Citations based on Custom Source Templates, and 

those Custom Source Templates already exist in the destination file, they will be duplicated  

b. In v9, this function is actually an internal GEDCOM export and GEDCOM import of the 

selected data between 2 RootsMagic database files.  

i. All limitations and cautions regarding using GEDCOM to exchange RootsMagic data (see 

end of this section) apply to Drag & Drop too. 

ii. Remember:  Changes you have made in the past regarding Fact Types to export/not 

export into a GEDCOM file should be reviewed to reflect which facts you want 

transferred to the destination database file. 

iii. Unlike an actual import of a GEDCOM file, you are not given the option to add a Source 

Citation to the People and/or Facts “dropped” into the database to document where 

they came from. 

c. Starting with v10, this function is now a direct transfer of RootsMagic data, bypassing the 

GEDCOM limitations that existed in earlier versions.  

d. In v10 (v9 limitations can be found in GEDCOM Import/Export section) RootsMagic DOES 

NOT check for duplicate People. So, after the new data is “dropped” into the file: 

i. Check for duplicate People 

ii. When duplicate people are found, each person must be Merged and reviewed for: 

(1) Duplicate/similar Facts with different information 

(2) Duplicate/similar Source Citations for the same Fact  

iii. New Custom Facts are created for Fact Types that do not match existing Fact Types 

e. All tagged data is transferred, except Family Facts involving a Spouse that is not also being 

transferred.  

2. Add Parent, Spouse and/or Child links where appropriate between the newly added people and 

those already in the database.  

3. Can be used to add people to your master database, extract a portion of your master database, 

or create a set of data to be “further processed” using GEDCOM export capabilities (privatize 

living people, etc). 
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DATABASE TOOLS 

1. Sometimes the Birth & Death dates listed in the Index side area are not automatically updated 

when a Person’s corresponding Facts are edited. Running the “Rebuild Indexes” Database Tool 

will re-sync the Index dates with the current dates for each event. 

2. Sometimes you will notice a completely empty entry for a Person (no RIN displayed, but 

otherwise looks like it is a Person record created in the database. These are referred to as 

“Phantom Records.” Running the “Clean Phantom Records” Database Tool will remove these 

non-existent entries from the database 

3. The decision of whether to wait until you notice a discrepancy, do it once a year, a month, a 

week or after significant work has been done is left is up to each User to decide 

4. When you decide to run a Database Tool, it is recommended that you run all 4 Database Tools 

since each tool runs very quickly.  

5. The order in which the Database Tools are run does not matter 

6. The Database Tools can be accessed from the FILE and the TOOLS Pages 

BACKING UP A DATABASE: 

1. General Info: 

a. Backups can be initiated 3 different ways: 

i. Closing a file by clicking on the “X” (or Mac equivalent) will cause the Backup popup 

window to appear, if this setting has been turned on in the SETTINGS Page, Program 

Settings View. Closing a file from the FILE Page will not cause the Backup popup window 

to appear regardless of this setting. 

ii. Selecting File Page, then Backup 

iii. Selecting Tools Page, then Backup database 

b. Can be set to include associated media files. However, this consumes a significant amount of 

storage space and adds considerable amount of time to perform each RootsMagic Backup 

i. Primarily recommended when you want a complete set of information (database and 

linked media files) for the purpose of archiving a copy or perhaps sharing a copy of data 

and all linked media files 

ii. All media files are placed in a single media folder inside the backup file. When restored, 

the media files are all restored in a single media folder, any file/folder structure used to 

organize media files prior to the backup is lost. 

iii. If broken links exist in the database, the corresponding media files will not be backed up  

iv. Regardless of what is selected, media files not linked to anything in the database WILL 

NOT be backed up 

c. Are primarily intended to support “Undo” resurrection of corrupted database files, 

accidentally deleted data or files, view archived data to compare with current version of the 

database and/or to transfer a database to another computer 

d. RootsMagic Backup files are actually “zip files.” If necessary, you can change the file 

extension to “.zip” and then use separate Zip file software to extract the compressed 

information 

2. When to backup a database file: 
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a. Anytime you have entered/changed data you would rather not re-enter should something 

unexpected occur to the file (for me, usually once per day of editing when closing the file) 

b. Prior to performing a major change that can affect multiple records in one action (Examples: 

cleaning up Place Names, Sources & Citations, Merging Duplicates, Search & Replace, Drag & 

Drop people into existing tree, importing GEDCOM data, downloading data from online 

sites, etc) 

c. Plus, prior to using any of the following Tools found on the TOOLS Page: Rearrange children 

or spouses across the whole database, Delete everyone in a group, Change fact type for 

everyone, Remove a fact type from everyone, v10 Add a fact to everyone in a group, and 

DataClean 

3. If creating a second (or more) Backup in the same day, add a differentiator (dash number or a, b, 

c…) at the end of the filename to make it unique to prevent overwriting earlier Backups, and 

also order the files sequentially when sorted by filename 

RESTORING A BACKUP 

1. General Info: 

a. If you have a RootsMagic 7 Backup file and do not have the corresponding database file, you 

can import the Backup file into RootsMagic 9 by using the Restore function. 

b. When you Restore a Backup file, the restored file will have the filename of the original 

database file and cannot be changed prior to restoring it. If you do not want your current 

version of the file to be overwritten, you must either restore the file to a different folder, or 

move and/or rename your current database file prior to restoring the Backup file. 

c. If your Backup file includes Media files, all linked Media files will be placed in a single folder 

created in the location where the file is restored to and any file organization structure you 

are using will be lost. 

COMPARING DATABASES 

1. General Info: 

a. The % Match value is the result of comparing “all” information in the database about the 

Person, not just what is displayed in the Compare Files window. A match of 98% or more 

should be considered the same. 

b. The Edit Window can be opened for the selected person in the “primary” file (the open file 

from which the File Compare function is initiated). The Edit window cannot be opened for 

the person’s record in the other file being used. 

c. When selecting Notes, Sources or Media, whichever file you click on becomes the “source” 

for any selected items to be moved to the other file. 

d. For Sources, you can only view the full Source Citation from one file at a time  

e. When a person is only present in one file, a Copy To File button appears to allow copying of 

all of the person’s information to the other file. However, the copied person will not be 

linked to anyone or contain any Family Facts (which depend on linking to other people). Any 

required linking or addition of Family Facts must be done as a separate action. 

2. Given the limitations on Editing People, viewing Source Citations and Media files while using the 

Compare function, if you expect to be moving a lot of information, or copying people between 
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files using the Compare function, you may want to consider how you want to make notes on 

things that need to be done afterwards. Some options are: 

a. Take screen shots 

b. Create an Individual List report with all "Information to include” & “Other” options 

unchecked and save it to a Word or Excel so that you can search and insert notes, etc and 

things to do after exiting the Compare function 

IMPORTING LISTS 

1. Up through RM9, only entire Lists can be imported. From RM10 and on, you can select individual 

items within a List type to import 

2. When importing a Fact Type list, RootsMagic imports all Fact Types, except the default 64 Fact 

Types included in every RootsMagic file.  

a. Unlike the default 64 in a new file, these other Fact Types will be imported preserving all the 

settings as they are in the source file. This includes whether or not it will be exported to a 

GEDCOM file 

b. If a Fact Type list is imported into a file that already has data in it, duplicate Fact Types may 

be created that should be cleaned up.  

3. Similar to importing a Fact Type List, when importing an Association Type list, RootsMagic will 

import all of them, except the 16 built-in Association Types included with every file. The same 

caveats for preserving settings and duplicates also apply to Association Types. 

Note:  If you have an individual Custom Source Template file (*.rmst) that was exported from a 

RootsMagic file, these files are imported from the Source Template List window (see Working 

with Sources > Source Templates in Online Help). 

4. When importing a list of (Custom) Source Templates from a database file, if they already exist in 

the destination file, they will be duplicated.  

5. RM9, lists of Addresses and Custom Association Types cannot be imported. 

6. Importing Color Code Sets will import the labels for each Color Code Set and corresponding 

labeled Colors. 

IMPORTING/EXPORTING DATA FROM AN EXISTING FILE VIA GEDCOM 

1. General information about working with GEDCOM files and data: 

a. GEDCOM files (pre-v7.0) are text files and do not contain media images or files. Only the 

drive, path and filenames pointing to where your linked media files reside can be included 

b. GEDCOM files exported from RootsMagic contain established TreeShare and/or 

FamilySearch ID mapping established in the source database. When imported back into a 

RootsMagic file (or transferred via Drag & Drop), this mapping is preserved. 

c. RM9, for reference, here is a technical post discussing what transfers, what is lost and other 

issues that occur when transferring data between RootsMagic database files via GEDCOM 

and/or Drag & Drop:  https://sqlitetoolsforrootsmagic.com/gedcom-dnd-transfer-

losses/?fbclid=IwAR3kychhZq7qo7UNM1xohUbsdZ0SRYMNj6C7XuWQdznYkFHd4pEG

a5y8cn8  
d. For reference, the GEDCOM website (specification can be found here, along with a list of 

“Validators”) is:  https://www.gedcom.org  

https://sqlitetoolsforrootsmagic.com/gedcom-dnd-transfer-losses/?fbclid=IwAR3kychhZq7qo7UNM1xohUbsdZ0SRYMNj6C7XuWQdznYkFHd4pEGa5y8cn8
https://sqlitetoolsforrootsmagic.com/gedcom-dnd-transfer-losses/?fbclid=IwAR3kychhZq7qo7UNM1xohUbsdZ0SRYMNj6C7XuWQdznYkFHd4pEGa5y8cn8
https://sqlitetoolsforrootsmagic.com/gedcom-dnd-transfer-losses/?fbclid=IwAR3kychhZq7qo7UNM1xohUbsdZ0SRYMNj6C7XuWQdznYkFHd4pEGa5y8cn8
https://www.gedcom.org/
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e. For Reference, the Family Tree Analyzer tool (Windows only) can be used to look at and 

analyze the data in GEDCOM files:  https://ftanalyzer.com  

2. RM9, the Drag & Drop function is actually an internal GEDCOM export and GEDCOM import of 

the selected data between 2 RootsMagic database files.  

a. If you’ve made changes in the past regarding which Fact Types to not export via GEDCOM, 

you may want to review and change the settings back to have them included 

b. Unlike an import of an external GEDCOM file, you are not given the option to add a Source 

Citation to the People and/or Facts “dropped” into the file. 

3. When importing data using a GEDCOM file: 

a. If you elect to add a GEDCOM Import Source Citation to added People and/or Facts, the 

information you enter will appear in reports in the following form: 

i. Source Name: GEDCOM file imported on [DATE] 

ii. Footnote and Short Footnote: GEDCOM file submitted by [NAME], [ADDRESS INFO]. 

Imported on [DATE] 

iii. Bibliography: GEDCOM file, [NAME] 

iv. The corresponding Citation will be given the same Name as the Source Name and 

applied as a “reuse” of the Citation (change 1 Citation and all get changed). 

b. After performing a GEDCOM import, check the folder where the destination database file is 

located using a File Manager/Explorer program and open the LST file with the same name as 

the imported GEDCOM file (using a program that can read text files) and check for any 

issues encountered by the import tool 

i. You may need to open the GEDCOM file itself (using a program that can read text files) 

to analyze what the data issue is tagged to/located within the imported data set that 

the LST file is referring to.  

c. When a group of people are brought directly into an existing file via GEDCOM import (or 

RM9 Drag & Drop): 

i. RootsMagic DOES NOT check for duplicate People. So, after the new data is inserted: 

(1) Check for duplicate People 

(2) When duplicate people are found, each person must be Merged and reviewed for: 

(a) Duplicate/similar Facts with different information 

(b) Duplicate/similar Source Citations for the same Fact (note that most imported 

Source Citations not added via Drag & Drop will be imported using the Free 

Form Source Template) 

ii. New Custom Facts are created for Fact Types that do not match existing RootsMagic 

Fact Types 

iii. Sources and Citations are created using the Free Form Template, rather than your 

preferred Source Template type(s). 

iv. Place names and Place Details will reflect what was in the GEDCOM file and may not 

conform to your naming and/or structure conventions. 

v. Add Parent, Spouse and/or Child links where appropriate between the newly added 

people and those already in the database.  

d. Check for Broken Media Links in imported data (media files are not included in a GEDCOM 

file, only drive, path and filename location information).  

https://ftanalyzer.com/
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e. Depending on your intended use, you may need to clean up the imported information to 

meet your standards/conventions. 

f. Consider whether you want to make a Backup of your database file to archive a snapshot of 

what it looked like immediately after your importation of this new set of cleaned up data. 

4. When exporting data to a GEDCOM file, do the following first: 

a. If you intend on privatizing living people, run an Advanced Search to identify all people 

currently identified as living in the Group you intend on Exporting first: 

i. Go to SEARCH Page and select Advanced Search View 

ii. Click on the Find button 

iii. Select “Living Flag” in the first “Select field” box and “Is True” in the Logic box, and then 

click on “OK” 

iv. The resulting list is all of the people in your Group that will be privatized. If you see 

people that should not be privatized, click on Edit button and make the necessary 

corrections 

v. Repeat until review is complete 

b. The initial default setting for each newly created RootsMagic file is set to export all (default) 

Fact Types. Decide whether you want all, or only some Fact Types to be exported. Confirm 

export settings for each Fact Type is set as you want, as follows: 

i. Select PEOPLE Page, click on 3 dots icon on the People Menu Bar and select Fact Type 

List 

ii. Note where the “Include GEDCOM: Yes/No” information is located on the Fact Type 

screen 

iii. Scroll through the list of Fact Types to confirm the desired Fact Types you want to 

include are set to “Yes” and any Fact Types you do not want to include are set to “No” 

Note: If you click on the first Fact Type, you can then scroll through the list by using the 

Down Arrow. 

iv. To change a setting, click on the EDIT button, check/uncheck the “Include when” 

Exporting GEDCOM files” box and click OK 

v. Continue to the end of the Fact Type list, then click OK 

c. If exporting a subset of people in your database and you have not created a Group yet, you 

may want to create a new Group prior to starting the process to export the GEDCOM file 

i. Remember that Couple/Family Facts will only be included with the export if both people 

are included in the export 

d. If the data you want to export contains links to media files, check & fix broken media links 

(MEDIA Page > 3 dots > Fix broken media links). 

e. If you want the colors assigned for each Color Code Set to be included in the export, you 

must ensure that “Extra details (RM specific)” is selected on the GEDCOM Export Options 

window. Only the color assignments are included, the Color Code Set and Color labels are 

not included in the resulting GEDCOM file. 

f. Now you are ready to export the GEDCOM file 

g. After exporting data to a GEDCOM, if you set some Fact Types to not export, you should 

decide whether to reset them to Yes now, or wait until the next time you perform a 

GEDCOM Export or Drag & Drop operation to review all their export settings. 
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WORKING WITH PEOPLE 

https://help.rootsmagic.com/RM9/working-with-people.html 

https://help.rootsmagic.com/RM10/working-with-people.html 

General information : 

1. After importing data from other sources, you may discover multiple “Primary Name” Facts for a 

person, when there should only be one. To reset the Primary Name, create a new, temporary, 

name, designate it (temporarily) as the Primary Name. This will reset all other Primary Names to 

Alternate Name Facts. Then, select the desired “real” Primary Name and delete the temporary 

name created. 

2. Sometimes you will discover a person has an unexpected “Unknown Spouse” listed in the 

Descendant View. This is not a record for a person in the database, it is an indication of a 

Family/Couple relationship created either by attaching a Child to just 1 parent or a Family Fact 

that requires a Couple (like Marriage) and only 1 person is associated with it. There are 

situations that can occur where the original cause was corrected, but the Family/Couple with an 

unidentified Spouse still exists in the database. These can be corrected by following the steps 

listed in the Problem Solving Information section at the end of this document. 

a. If caused by data brought in from another source, when possible, it is best to return to the 

source and correct the problem there and then re-import the information 

3. Information on dealing with sensitive family situations such as transgender relatives can be 

found here: 

a. Yvette Hoitink Blog: https://www.dutchgenealogy.nl/ask-yvette-how-to-record-

transgender-people/  
b. Stewart Traiman’s website: https://sixgen.org/  

4. General information on what and where to enter people’s names can be found here: 

a. Tamura Jones blog: 

https://www.tamurajones.net/GenealogyNameBasics.xhtml?fbclid=IwAR2WpaawV8JtY5

1XDuAwVqLH_3OAE5d3WAShW7moC84ElCFj9nH9W8-0aHM  
5. Naming convention information for different areas of the world can be found here: 

a. Personal Names – Wikipedia: https://en.wikipedia.org/wiki/Personal_name  

b. Dit Names – Wikipedia: https://en.wikipedia.org/wiki/Dit_name#  

c. Yvette Hoitink Blog – Dutch Farm Names: ii. https://www.dutchgenealogy.nl/farm-names/  

d. Scandinavian Family Names - Wikipedia: 

https://en.wikipedia.org/wiki/Scandinavian_family_name_etymology  
e. Patronymic Names – Wikipedia: https://en.wikipedia.org/wiki/Patronymic#  

ADDING PEOPLE 

1. Selecting “Add an Individual” adds a person to the database with no relationship to anyone else. 

The other Add options (Spouse, Child & Parents) establish the selected relationship to either a 

new, or existing person. 

2. It is a best practice to add People from a People View that ensures you are establishing the 

correct relationship links: 

https://help.rootsmagic.com/RM9/working-with-people.html
https://www.dutchgenealogy.nl/ask-yvette-how-to-record-transgender-people/
https://www.dutchgenealogy.nl/ask-yvette-how-to-record-transgender-people/
https://sixgen.org/
https://www.tamurajones.net/GenealogyNameBasics.xhtml?fbclid=IwAR2WpaawV8JtY51XDuAwVqLH_3OAE5d3WAShW7moC84ElCFj9nH9W8-0aHM
https://www.tamurajones.net/GenealogyNameBasics.xhtml?fbclid=IwAR2WpaawV8JtY51XDuAwVqLH_3OAE5d3WAShW7moC84ElCFj9nH9W8-0aHM
https://en.wikipedia.org/wiki/Personal_name
https://en.wikipedia.org/wiki/Dit_name
https://www.dutchgenealogy.nl/farm-names/
https://en.wikipedia.org/wiki/Scandinavian_family_name_etymology
https://en.wikipedia.org/wiki/Patronymic
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a. When known, add Parents to a Child as a Couple, rather than adding Mother and Father 

separately.  

i. Caution: If the Couple has already been established, don’t use the individual Add Father 

and Mother buttons to add additional Children from the Pedigree View. This will result 

in each Child being assigned to its own unique set of Parents (even though they may be 

the same 2 People), requiring additional linking/unlinking to properly group all the 

Children into the same Family/Couple. 

b. Add Children to a Couple from the Family or Descendant View, where you can ensure you 

are linking to the correct Couple 

3. People can be added by clicking on the Add a Person (+) icon; in the Pedigree & Family Views, 

clicking on the + Add Child, Spouse, Mother, Father boxes; hover over a person and right 

clicking; keyboard shortcuts, Command Palette; or from the selected person’s sidebar info view. 

4. The minimum data that must be entered for a new Person to be added to the database is either 

their Given or Surname. All other information is optional. 

5. If you know 2 people are siblings, but the parents are unknown, you can connect them by 

entering their Father as a new person with the same Surname as a placeholder. Once created, 

you can link the siblings to the Father to establish their relationship. 

6. If desired, you can create a person with no name. First create the person with a temporary 

name, Save the new Person to create the database record for them. In the Edit Person window, 

delete their temporary name. It is highly recommended that you turn on RIN display to aid in 

differentiating multiple records with no name entered. 

EDITING A PERSON 

1. You may want to position the Edit Window so that part of it is outside the area of the main 

window so that you can click on it to bring it to the front should it get hidden 

2. You can have up to 3 open Edit windows and still switch between Pages and database files.  

3. To close an Edit Window, click on the x in the corner 

4. You can change the labels used when referring to a Couple’s by their Children (Spouse row) 

and/or the Parent’s relationship to their Children (Parents row) 

EDIT PERSON HEALTH HISTORY 

EDIT PERSON DNA MATCHES 

UNLINKING PEOPLE 

1. Unlinking can be performed from any People Page View. However, it is a best practice to 

perform unlinking from a View that ensures both you and RootsMagic clearly understand which 

relationship link you are about to unlink. The best View to use is the Family View, where 

Children are shown with only 1 set of Parents and when a Parent has multiple Spouses, which 

one is part of the Family/Couple involved in the unlinking. 

2. When a spouse is unlinked, if the Couple had children linked to them, the children remain linked 

to the spouse and their other parent will then be identified as “Unknown Spouse.” 

DELETING PEOPLE 
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1. In most cases, deleting a person is not the way to correct the problem you are seeing. Prior to 

proceeding with a deletion ask yourself: 

a. Should I Manually Merge them instead?   

b. Should I leave this person (or Family) floating in my database file, separate from my main 

tree to preserve what I know about them? 

c. If the answer to the 2 questions is no, then it’s time to delete the person 

2. Remember, when you delete a Person: 
a. Any links the deleted person (or Family) had with other People in the database are also 

deleted. This includes: 
i. Links to the Person’s Parents, Spouses and their Children  

ii. Association links to other people in the database 
iii. Shared Facts, shared with other people in the database 
iv. Links to Source Citations, Media, Tasks, etc are deleted 

b. Even though links to Source Citations, Media, Tasks, etc are deleted, the actual Source 
Citations, Media, Tasks, etc ARE NOT DELETED from the database. They are just used in 
fewer places in the database. 
i. RM10, after deleting a person, you can review the TOOLS Page > Enhanced Properties 

List reported numbers of data types that are “Unused” and decide if you want to select 
and delete them as well. 

ROOTSMAGIC EXPLORER 

1. The RootsMagic Explorer window can be utilized when using the following functions: 

a. Creating and editing Groups (in RM9, only Free Form Groups) 

b. One of several options to apply Color Coding 

2. The Mark/Unmark capability allows very creative ways of defining a group of people. 

a. There is no limit to the number of Mark/Unmark operations you can perform to create the 

final list of “selected” people you want to create.  

b. However, if you perform multiple Mark/Unmark operations, they cannot be saved to be 

repeated again later, after the current use. It is important to record what you do for each 

step and the order the steps are performed in order to re-create the same list criteria in the 

future.  

i. In RM10, you can create the Group that can be refreshed by creating a Rules Group, 

where a separate Rule is created for each Mark/Unmark operation, applied in the 

desired order. 

c. RM9, if you plan to select people using a single application of the “By Data Fields” option, it 

is recommended that you create a Group using the Saved Criteria option instead. This will 

allow you to refresh the group membership any time you want in the future.  

3. The same data fields available for Advanced Person Search are also available within the 

RootsMagic Explorer. Refer to the Search section of this Handout for the table listing all data 

fields that can be used. 

GROUPS 

1. Caution: Be careful when naming Groups. RootsMagic will allow you to create 2 different 

Groups with the same name 
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2. When large Groups (>1,000 people) are created using the Search Criteria capability and this 

Group is used to filter the list of People shown in the People List or Index, the performance of 

RootsMagic is known to slow down its response time to other actions.  

3. Using Groups based on Custom Facts is a powerful way to define collections of People for work, 

reporting, etc. Custom Facts can be privatized to prevent them from being included in reports, 

etc 

4. Group membership is not updated as you change information about people, they only get 

updated when you decide to refresh each Group 

5. When you Merge people that are members of different Groups, only the Group membership of 

the Primary Person is retained by RootsMagic. All Group memberships of the person that ends 

up being removed is not passed to the remaining person’s record. 

COLOR CODING PEOPLE 

1. Consider reserving one of the ten color sets for “temporary” color coding in case you need to 

use it to support a specific task you are working on. 

2. Unless you plan to select people using the RootsMagic Explorer window, the color coding will be 

based on the person selected prior to opening the Color Coding tool 

3. If you plan on applying the color coding by using Groups, the Groups must be created prior to 

opening the Color Coding tool. 

4. A good discussion of RootsMagic color codes and color selection can be found at:  

https://sqlitetoolsforrootsmagic.com/colorcoding-

rm8/?fbclid=IwAR2rdgnZeTALa1LNvu_NN9sFHX_y9-gjCnm23vo3Z_krTAwOY3ECUZkV_fo  

 

SET RELATIONSHIPS 

1. The person you set as the “Root Person” and the person you select to "Show Relationships To” 

are two different designations in the database file. 

2. Set Relationships does not automatically update relationships when relationship links are 

changed or new people are added to the database. You will need to re-run the Set Relationships 

function to update the information displayed. 

WEBHINTS 

General Information: 

1. WebHint Icon Legend:  https://help.rootsmagic.com/RM10/webhints.html  

2. Per RootsMagic Tech Support, each company decides when to update their WebHints which 

results in sending the latest data about each person in the database and waiting for the 

company to provide an updated set of Hints for each person. The number of WebHints for any 

person can change at any time due to: 

a. Changes made to the Person’s information in the RootsMagic database  

b. The addition of new online records or a new catalog collection applicable to the Person 

c. Other users finding and associating record information about the same person to their 

family tree 

https://sqlitetoolsforrootsmagic.com/colorcoding-rm8/?fbclid=IwAR2rdgnZeTALa1LNvu_NN9sFHX_y9-gjCnm23vo3Z_krTAwOY3ECUZkV_fo
https://sqlitetoolsforrootsmagic.com/colorcoding-rm8/?fbclid=IwAR2rdgnZeTALa1LNvu_NN9sFHX_y9-gjCnm23vo3Z_krTAwOY3ECUZkV_fo
https://help.rootsmagic.com/RM10/webhints.html
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3. After changing the status of a WebHint, it will not be reflected in the WebHint summary count 

window until the WebHint summary window is closed and re-opened. This triggers sending the 

updated information back to the company’s hinting system and waiting to receive updated Hints 

sent back to RootsMagic (in some cases, this can take several minutes). 

Ancestry WebHints: 

1. Ancestry generates Hints for the Ancestry Tree connected to your RootsMagic file and passes 

(mirrors) these as WebHInts to RootsMagic via the TreeShare connection. 

2. Ancestry WebHints can only be seen while logged into Ancestry via TreeShare. 

3. Unlike the TreeShare function which provides transfer of information in both directions, 

processing WebHints only results in changes to the RootsMagic database. If changes are desired 

to be made to the linked Ancestry Tree, TreeShare must be used to select which changes you 

want to be made to the connected Ancestry Tree. 

4. Regardless of where you click on the Ancestry Hints row in the WebHints window, the Ancestry 

Hints window opens, showing all Hints grouped by type (Records, Other Member Trees & 

Photos and Stories) and sorted by status (Undecided, Accepted, Rejected). 

5. Users without a subscription that provides access to Records & Other Member Trees can still 

view records that Ancestry makes available for free and all User uploaded Photos and Stories. 

Since you cannot tell which records are free from within RootsMagic, you may find it useful to 

look at each hint while looking at the detailed field information contained in the Hint compared 

to the information entered in your RootsMagic database 

a. In order to view Photos and Stories files, Users without a subscription must first attach the 

file to the person and then open/view the file from the Edit Person Window 

6. Unlike from within Ancestry, Users without a subscription can change the status of WebHints 

(Undecided, Accepted or Rejected), and revise the status in the future, if needed. Status changes 

made to RootsMagic WebHints are passed back to the connected Ancestry Tree list of Hints. 

7. Processing of Ancestry WebHints involves the following basic steps: 

a. View WebHint, when possible 

b. View highlighted data differences between Ancestry Hint and RootsMagic person 

c. Decide whether sufficient information is available to decide: 

i. Hint is applicable and should be Accepted 

ii. Hint is not applicable and should be Rejected 

iii. Further information is needed before deciding applicability and should be left as 

Undecided 

d. When a WebHint is accepted, decide whether to transfer data from hint to RootsMagic 

person and/or open Edit RootsMagic Person window to make changes manually 

i. Data can be transferred from Ancestry to RootsMagic as a new Fact or replace data in a 

current Fact 

e. Decide whether to add/modify the Ancestry Source Citation in RootsMagic 

f. Decide whether changes resulting from the WebHint should be “pushed” back to Ancestry 

Tree using TreeShare 

FamilySearch WebHints: 
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1. FamilySearch WebHints can only be seen while logged into FamilySearch via RootsMagic  

2. FamilySearch provides Record Hints for the FamilySearch Family Tree (FSFT) based on the 

information entered for the people in the RootsMagic database and whether or not you have 

matched the person to the corresponding person in the FSFT.  

3. Processing these WebHints does not change any information about the Person in the 

RootsMagic file, it only affects the Hints for the people in the FSFT and whether or not the 

hinted record gets attached to the FSFT person. 

a. When the RootsMagic person has been matched to a person in the FSFT, both Pending and 

Confirmed Hints are provided (not sure if Rejected hints show in updated status or just 

disappear from the WebHints window).  

i. Confirmed Hints means they are attached to the FSFT person.  

ii. Not all Record Sources attached to a person in the FSFT are presented as WebHints in 

RootsMagic. 

b. When the RootsMagic person has not been matched to a person in the FSFT, only Pending 

Hints are provided. 

4. Evaluation and processing of each WebHint is performed starting at the FamilySearch webpage 

linked to the Hint entry in RootsMagic and using the established FamilySearch process for 

dispositioning FSFT Hints. 

5. If you determine that an unmatched person’s Hints have helped you identify the matching 

person in the FSFT, close the WebHints window and click on the FamilySearch Not Linked icon to 

open the FamilySearch Person Tools window (see Online Features-FamilySearch in Online Help) 

to match the person. 

6. If after processing Hints in the FSFT you want to add data to the RootsMagic database from the 

FSFT, see the Online Features-FamilySearch section in the Online Help. 

FindMyPast WebHints: 

1. FindMyPast provides only Record Hints based on the information entered for the people in the 

RootsMagic database. 

2. Regardless of where you click on the FindMyPast Hints row in the WebHints window, a browser 

window opens showing all the FindMyPast WebHints for the person. 

a. Each listed Hint identifies the FindMyPast Record database, with very limited specific 

information about what the record contains 

b. If you use a free account and log in, you cannot use the Review and Accept functions, but 

you can Reject a Hint 

i. In some cases, you may still be able to go into the FindMyPast site and search for the 

person and locate the Record Hint and see the complete database index transcription  

c. If you have a paid subscription and log in, you can Review, Accept and/or Reject each Hint 

i. The ability to change the status of a Hint is done from within FindMyPast and cannot be 

done from RootsMagic. 

3. Since there is no data exchange capability between RootsMagic and FindMyPast, any valid Hint 

information must be manually entered into the RootsMagic database, regardless of whether you 

have a subscription or not. 

MyHeritage WebHints: 
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1. MyHeritage provides Record and Smart Match (Member Tree) Hints based on the information 

entered for the people in the RootsMagic database. 

2. Regardless of where you click on the MyHeritage Hints row in the WebHints window, a browser 

window opens showing all MyHeritage Hints for the person, grouped by hint type (Records and 

Smart Matches). 

a. Each listed Hint identifies some, but not necessarily all information contained in the Hint. 

b. If you have a free account and log in, you cannot use the Review and Accept functions, but 

you can Reject a Hint 

i. If the Record dataset containing the Hint is marked as “Free”, you can Review and 

Accept the Hint 

ii. Similar to FindMyPast, you may find that you can access and review some Hint Record 

datasets by logging into the MyHeritage account, searching for the person, locate the 

Record Hint dataset and see the complete database index transcription entry. 

c. If you have a paid subscription and log in, you can Review, Accept and/or Reject each Hint. 

i. Tracking of Accepted and Rejected Hints is done within your MyHeritage account. 

ii. The ability to change the status of a Hint is done from within MyHeritage and cannot be 

done from RootsMagic. 

3. MyHeritage can suppress Hints that you have already attached to your MyHeritage family tree 

associated with the e-mail account entered in WebHint Settings. If activated, once a Hint is 

dispositioned in the MyHeritage account, it will be suppressed and not sent to RootsMagic as a 

WebHint. As a result, when filtered, I believe all WebHints listed will be Pending in RootsMagic. 

4. Since there is no data exchange capability between RootsMagic and MyHeritage, any valid Hint 

information must be manually entered into the RootsMagic database, regardless of whether you 

have a subscription or not. 

SET LIVING 

1. Since this tool can change multiple people at one time, it is recommended that you Backup your 

file before proceeding 

2. If sharing your data with online sites, care must be taken to correctly flag all living people to 

ensure the online sites properly protect information about living people. 

HEALTH HISTORY 

1. General Information: 

a. Health data cannot be searched, nor filtered, using any of RootsMagic’s Search tools  

b. Health data cannot be exported out of RootsMagic via Ancestry, FamilySearch or GEDCOM 

file export 

c. Health data can be transferred to another RootsMagic file using Drag & Drop (D&D). 

2. Health information entered in the Edit Person window Health View is kept separate from all 

Facts and other information used to create typical genealogy reports. This allows the separate 

tracking of health-related issues that might have hereditary connections without having to be 

concerned about inadvertently publicizing personal/private information regarding a person’s 

health history. 
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3. Similar to entering Addresses for living people to create/manage an address book of people, 

entering/tracking health history is optional data that has no impact on outputting standard 

genealogical information from RootsMagic, but does allow you to generate the Health History 

specific reports (Family Health History & Health Condicitons). 

4. The Health Condition Details data field is limited to 102 characters. However, the Health Note 

data field, like all Note fields in RootsMagic, has no character limitation. 

DNA TESTS 

1. General Information:  

a. RootsMagic provides 3 different built-in features specific to recording DNA data in the database 

file: 

i. “DNA Test” Fact Type: 

a. The default configuration doesn’t use the Description field. Like other Fact Types, it can 

be activated and added to the Sentence Template, if desired. 

b. Additional Custom Fact Types can be created 

c. Defining Roles and Sharing the Fact with others can be useful, depending on your 

approach to adding and managing DNA Test and Match data. 

d. Facts can be searched and filtered. 

e. Facts can be exported out of RootsMagic via Ancestry, FamilySearch and GEDCOM file 

export 

ii. “DNA Match” Association Type: 

a. The default configuration uses the Description field. 

b. Additional Custom Association Types can be created. 

c. Associations cannot be shared, so an Association is required for each Match being 

recorded, potentially leading to 100’s or 1,000’s of entries for a Person. 

d. The display of Associations in the Edit Person window can be turned off. Unfortunately, 

it will apply to all Associations, not just the DNA Match Association. 

e. Associations can be searched and filtered, but you can’t select specific Association Types 

f. Associations cannot be exported out of RootsMagic via Ancestry, FamilySearch or 

GEDCOM file export 

g. DNA Page data can be transferred to another RootsMagic file using Drag & Drop (D&D), 

but only if both people forming the DNA Match are included in the D&D operation. 

iii. Edit Person Window - DNA Page: 

a. DNA Page data cannot be searched, nor filtered, using any of RootsMagic’s Search tools  

b. DNA Page data cannot be exported out of RootsMagic via Ancestry, FamilySearch or 

GEDCOM file export 

c. DNA Page data can be transferred to another RootsMagic file using Drag & Drop (D&D), 

but only if both people forming the DNA Match are included in the D&D operation. 

b. User submitted ideas for managing DNA data in RootsMagic: 

i. Include URLs for the Profile Page at DNA sites using WebTag , Description field, or Note 

(URLs in a Note can be accessed by pressing Crtl-Key and clicking on URL) 

a. Can be treated as Private data by enclosing in curly brackets 

b. Can be placed in a Custom Fact Type that can be enabled/disabled for Narrative Reports 

when desired 
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ii. Use Tasks to tag a DNA Fact or Association and rely on the Task Research Log folders to track 

progress in identifying MRCAs (Most Recent Common Ancestor). 

iii. Use Sources for each DNA testing company to place DNA match details, notes and Match 

Profile URLs in the Citation Details for each Match (which can be linked to both people) 

iv. Use a DNA (🧬), or other colored symbol, Emoji for visibility purposes. 

c. There are no provisions for adding DNA data using bulk/automated methods. All data must be 

manually entered 

d. Time should be spent developing a consistent “Overall “DNA Strategy” that weighs the Pros & 

Cons of each of the above built-in and Custom methods of documenting DNA Test and Match 

information that supports your: 

i. Desired output reporting capabilities 

ii. Desired searching, filtering, grouping and color-coding capabilities 

iii. Desired research/analysis capabilities 

iv. Desired post-research/analysis capabilities 

2. DNA Match information entered in the Edit Person window DNA Tab is kept separate from all Facts 

and other information used to create typical genealogy reports. This allows the separate tracking of 

DNA Match-related information without having to be concerned about inadvertently publicizing 

personal/private information regarding a person’s DNA Matches. 

3. Similar to Health History data, entering/tracking DNA Matches is optional data that has no impact on 

outputting standard genealogical information from RootsMagic, but does allow you to generate the 

DNA specific reports (DNA Kinship List & Leeds Method Report). 

4. Depending on your specific situation, entering DNA Shared Match information from multiple 

companies into one place may be useful when attempting to view and analyze all information 

available (including having software perform Leeds Method analysis rather than doing it manually or 

using a spreadsheet) in order to solve, or confirm, family tree relationships. 

5. If unfamiliar with DNA and/or DNA analysis techniques, I recommend you consider joining the GFO 

DNA Q&A Special Interest Group:  https://gfo.org/learn/special-interest-groups/dna-qa.html  

6. Entering DNA numerical values can be done using the slider bar, or by clicking on the number field 

and directly keying in the desired number. 

7. RootsMagic does not automatically update “Tree Relationships” after the initial entry of a DNA 

Match. To update “Tree Relationshpis” after adding new links between people, on the DNA Tab, you 

must select each Match and click on the blue “Update” button in the lower right to force 

RootsMagic to re-evaluate the Match’s “Tree Relationship.” 

8. DNA Notes cannot be included in any of the RootsMagic DNA reports, DNA Notes are only viewable 

when viewing a specific Match’s information on the DNA Tab 

9. Every DNA Match entry that does not have a known tree relationship will start as a floating tree 

containing only 1 person.  

a. Consideration should be given to establishing a “system” for being able to discern floating trees 

containing DNA individuals with unknown family linkage from individuals added to your 

database for non-DNA reasons (FAN club, One Name Studies, etc) without having to open the 

person’s Edit Person window to review their detailed information. Some possible options 

include: entering something in Name Suffix field, using the Ref Number Fact Type, using Emojis, 

etc 

10. DNA Reports: 

https://gfo.org/learn/special-interest-groups/dna-qa.html
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a. DNA Kinship List: 

i. Have a DNA Match checkbox: Checked will include Matches that have a DNA Match. 

Unchecked will exclude DNA Matches 

a. Note: If relationship links have been added after initial entry of the DNA  Matches to be 

included, you may want to consider updating the Tree Relationshp for each DNA Match 

that currently does not have a Tree Relationship to ensure the latest known information 

is reflected in your report. 

ii. Don’t Have a DNA Match checkbox: Checked will include People that don’t have a DNA 

Match, but do have a Tree Relationship. Unchecked will exclude everyone that doesn’t have 

a DNA Match 

b. Leeds Method Report: 

i. The colored boxes in the report with the filled-in black dot are the Matches initially assigned 

that color 

ii. When the report is saved to an Excel file, the colors are not included, but the filled and non-

filled-in dots are included. 

iii. When the report is saved to a CSV file, the colors are not included and the dots are 

represented by character strings, which will need to be replaced with a more recognizable 

symbol after importing into the destination software.  
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WORKING WITH FACTS 

https://help.rootsmagic.com/RM9/working-with-facts.html 

https://help.rootsmagic.com/RM10/working-with-facts.html 

THE EDIT PERSON WINDOW 

1. (Not in RM9 Help) You can switch to close relatives of the current person in the Edit window, 

without leaving the Edit Window, by clicking on the down arrow for the appropriate Spouse or 

Parent to pick the desired Spouse, Child, Parent or Sibling you want to switch to  

2. The Show Relative Events check box shows: 

a. Events for the relatives selected on the Options window that occurred during the lifetime of 

the person being edited. Note that when a relative’s Marriage Fact is selected, the sentence 

displayed in the Sentence area will only include the relative and not their Spouse. To view 

the complete sentence that will appear when a Narrative report is generated, you must view 

it from the relative’s Edit Person window. 

b. If the person being edited does not have a Birth or Christen date then no relative events are 

displayed. 

3. When the “Slide-In Workflow” setting is set under Settings > Program Settings, clicking on the 

corresponding column location for a Fact causes the information to appear on the left side and 

the additional detail information on the right side.  

ADDING FACTS 

1. Facts can be added by clicking on the Add Fact (+) icon, or hover over a Fact and right clicking. 

2. When selecting a Fact Type, you can use partial word searches and use the wild cards “_” and 

“%”. You can also use the quote (“) to indicate the name must start with the following letters 

Date Formats 

1. RootsMagic supports four Date Formats. The following image shows how each is displayed when 

the SETTINGS > General Settings > Date Format is set to “10 Jan 1959.” When set to a different 

option, these formats are presented slightly different: 

 

2. Quarter Dates – This date format is currently not addressed in the Online Help: 

a. Quarters can be entered in a variety of recognizable formats which are converted into the 

form of: March Quarter, June Quarter, September Quarter & December Quarter 

b. In addition to entering the resulting format, various combinations of “first” or “1” and 

“quarter”, “qtr” or “q” are recognizable data entry formats 

c. Quarter dates are sorted as if they occurred in between the last day of the prior quarter and 

the first day of the listed quarter. For example, “March Quarter” would be sorted and placed 

https://help.rootsmagic.com/RM9/working-with-facts.html
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after events that occurred on 31 December of the prior year and before 1 January of the 

current year 

3. Directional modifiers – RootsMagic will recognize the following entered text and convert it to 

the indicated modifier: 

a. Enter either “b” or “bef” and RootsMagic will convert it to “before” 

b. Enter “untl” and RootsMagic will convert it to “until” 

c. Enter either “f” or “fr” or “frm” and RootsMagic will convert it to “from” 

d. Enter either “a” or “aft” and RootsMagic will convert it to “after” 

e. Entering a space after the modifier is optional, RootsMagic will automatically add one if it is 

left out during data entry 

4. Date Ranges - RootsMagic will recognize the following entered text and convert it to the 

indicated range: 

a. Between/And: 

i. Enter “bet” and RootsMagic will recognize it as “Between,” but the word “and” is still 

required for it to be a recognizable date format 

ii. As long as you insert the word “and” or “&” between the two dates, or partial dates, 

RootsMagic will recognize that it is supposed to be in the form of Between date1 and 

date2 

b. You can enter a hyphen and RootsMagic will convert it to an “en” dash, which is the proper 

character to use when placed between dates 

5. Date qualifiers - RootsMagic will recognize the following entered text and convert it to the 

indicated date qualifier: 

a. Enter “abt” and RootsMagic will convert it to “about” 

b. Enter “est” or “estimate” and RootsMagic will convert it to “estimated”  

c. Enter either “cal” or “Calc” and RootsMagic will convert it to “calculated” 

d. Enter either “c” or “ca” or “cir” or “circ” and RootsMagic will convert it to “circa 

Date Tools 

1. Both the Calendar and Date Calculator Tools utilize today’s Gregorian calendar. They do not 

have the ability to switch or account for the earlier Julian calendar. When working with people 

that lived in areas and times were using the Julian calendar, you need account for this by 

“translating” the tool result to account for the differences in the calendars. This link can assist in 

understanding when the transition took place for specific areas around the world:  
https://en.wikipedia.org/wiki/Adoption_of_the_Gregorian_calendar  

Description 

1. Certain functions can result in truncating or moving extra text to other places, thus the Online 

Help recommendation to limit Descriptions to 100 characters or less.  

a. Exporting Descriptions to a GEDCOM file, or using Drag & Drop to move data between 

RootsMagic files will result in the Description being truncated when longer than 100 

characters. 

b. Using TreeShare to transfer Descriptions to an Ancestry tree will result in the Description 

being truncated when longer than 256 characters and the remainder will be placed in a Note 

https://en.wikipedia.org/wiki/Adoption_of_the_Gregorian_calendar
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Notes 

1. Notes can be added to many different items in the database. For an individual’s profile, Notes 

can be added to several different areas (Person, Spouse, Parents and Facts). When developing a 

plan on how to use Notes in support of your research, time should be spent understanding how 

and where Notes added to the various items in the database appear, or don’t appear, when 

outputting data to one or more of the options (Reports, Websites, Online Sites and GEDCOM 

files). Here are sample reports showing where each type of Note appears: 

a. Narrative Report Note Placement Sample: https://gfo.org/file_download/inline/fa3105e6-

acc4-424b-881b-33c1ebc6d55f  
b. Family Group Sheet Not Placement Sample: https://gfo.org/file_download/inline/783c4e51-

1b6d-47c1-bb91-04474e2b5613  
2. There is no character limit for Notes 

3. If you hover over the Note field, a popup bubble will show a significant portion of the Note 

without having to open up the Note window 

4. There are some Note editing capabilities only available via keyboard shortcuts 

5. The Replace (Ctrl+R) function listed in the RM9 Help does not work. This misleading information 

has been removed in the RM10 Help. 

5.6.  If you have inserted URL hyperlinks in a Note field, you can open the hyperlink by pressing the 

Ctrl-Key and then clicking on the URL.  

FACT TYPES 

1. There are 64 built-in Fact Types which cannot be deleted, plus Associations. You cannot edit the 

name or abbreviation for the built-in Fact Types and Associations. Here is a link to a list of the 

built-in Fact Types and their default information: https://gfo.org/file_download/inline/8ff7b443-

1d40-4db0-84d5-cfce0d279373 
2. When data is imported from another source that contains Facts and Events that do not align 

with the built-in Fact Types, RootsMagic automatically creates a Custom Fact and adds it to the 

Fact Type list 

3. As a reminder, you can import a Fact Type list from another RootsMagic file. This is covered in 

the Databases section 

4. When to create a Custom Fact: 

a. You want to capture more granularity in your recorded information for searching, filtering, 

grouping, color coding, etc  

b. You want to exercise more control over Output formats and data content such as: 

i. Narrative Report sentence templates for printed vs website output 

ii. Separating Fact information you want included in output reports from information you 

never want included 

c. You can’t modify an existing Fact Type to support what you want to record because one or 

more of the following apply: 

i. The desired change(s) would negatively impact the pre-existing uses of the Fact Type 

https://gfo.org/file_download/inline/fa3105e6-acc4-424b-881b-33c1ebc6d55f
https://gfo.org/file_download/inline/fa3105e6-acc4-424b-881b-33c1ebc6d55f
https://gfo.org/file_download/inline/783c4e51-1b6d-47c1-bb91-04474e2b5613
https://gfo.org/file_download/inline/783c4e51-1b6d-47c1-bb91-04474e2b5613
https://gfo.org/file_download/inline/8ff7b443-1d40-4db0-84d5-cfce0d279373
https://gfo.org/file_download/inline/8ff7b443-1d40-4db0-84d5-cfce0d279373
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ii. The existing Fact Type is one of the “Special Fact Types” and it makes more sense to 

address this situation by using both the “Special Fact Type” and a new Custom Fact Type 

in combination 

d. You decide the “Miscellaneous” Fact Type is not good enough because one or more of the 

following apply: 

i. When viewing the person’s Edit Person window, you want to see something other than 

“Misc” in the “Facts” column to convey what the Fact is about 

ii. You expect to use it many more times and want to use a common Sentence Template 

specific to the Custom Fact 

iii. In the future, you want to be able to perform searches, apply Color Coding and/or create 

Groups based on the Custom Fact 

e. If your Custom Fact is only used once in your database, you probably should consider using 

the Miscellaneous Fact Type 

5. When a new Custom Fact Type is created: 

a. Caution: RootsMagic does not prevent you from re-using an existing Fact Type name 

resulting in 2 different Fact Types with the same name 

b. If a Sentence Template is not entered, RootsMagic automatically creates one in the form of:  

i. “[NEED TO DEFINE SENTENCE: FACTTYPENAME]” 

ii. Fact Types missing a Sentence Template can be found using the TOOLS > ENHANCED 

PROPERTIES LIST tool 

c. It is only created in the currently open database file. If you have other database files you 

want to use it in, you must use the FILE > IMPORT DATA > IMPORT LISTS function to add it to 

your other file(s) 

6. If you delete a Fact Type that has Facts based on it, all of the Facts will be deleted too, if you 

acknowledge the warning. Any links to Sources, Media and/or Tasks linked to the deleted Facts 

will also be deleted from the database. However, any Sources, Media and/or Tasks that are no 

longer linked to any other information in the database will still remain in the database file and 

can be found on their respective PAGES 

7. If you start your Fact Type search with a double quote (“), search results will only include Fact 

Types that start with the letters entered.  

8. Several of the built-in Fact Types have “special” uses in RootsMagic. They are: 

a. Birth, Christen, Marriage, Death & Burial Fact Types are used by RootsMagic: 

i. In standard reports that include Birth, Marriage and Death information 

ii. To calculate age - requires a date entered in a person’s Birth or Christen Fact 

1. Note: Some Users that have people with no Birth or Christen Fact, but have a 

Baptism Fact for a Person have decided to use the Christen Fact instead of a Baptism 

Fact and modify the Principal Sentence Template for the Christen Fact Type (or 

customize individual Facts) to state that the person was Baptized 

iii. To automatically uncheck a person’s “Living” checkbox – requires a person to have a 

Death or Burial Fact or, a Birth or Christen Fact with a date that is at least 105 years ago 

iv. To flag Problem Alerts (red dot with exclamation point) and include them in the Problem 

List report 

b. Primary Name: 
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i. Each person can only have 1 Primary Name Fact and it is automatically created when a 

person is added to the database 

ii. It is not available to choose from the Fact Type List 

iii. All the information about a person’s name that is used by RootsMagic is recorded here 

iv. There is no Sentence Template for this Fact Type. The Primary Name Fact information 

can be used in all Fact Sentence Templates defined for all other Fact Types 

c. Alternate Name: 

i. The data fields are the same as those for the Primary Name Fact Type 

ii. You can designate that an Alternate Name Fact become the new Primary Name Fact for 

a person. This makes the previous Primary Name Fact an Alternate Name Fact 

iii. Cannot be shared with other people 

d. Association: 

i. Although Association appears in the Fact Type List, Associations are different. Facts tend 

to be event-based information recorded about a person 

ii. Associations tend to be used to record, nonevent-based, non-family relationships 

between 2 people in the database 

iii. Cannot be shared with additional people 

e. Reference No (Ref #): 

i. By default, this Fact Type only uses the Description and Sort Date fields 

ii. The intended use is to record a preferred numbering scheme in the Description field 

which identifies people in the database 

iii. The Ref # can be appended to the end of a person’s name within RootsMagic in lieu of 

the RIN or FSID by going to SETTINGS > GENERAL SETTINGS and setting “Number to 

Display” to “REFN” 

f. LDS specific Fact Types: Used to interface with LDS specific information at FamilySearch 

9. Sample uses of Custom Fact Types: 

a. To manage status (work completion, level of documented Facts, group membership) of 

people in the database 

b. You want to modify the default Sentence Template of a built-in Fact Type (that isn’t one of 

the “special Fact Types” listed in this Handout) and be able to replicate the changes in 

additional database files using the IMPORT LIST function 

c. You want more granularity for a Fact Type to: search, filter, group, color code, etc, Like 

creating: “Census 1900” & “Census 1910” instead of the built-in “Census” Fact Type 

ADDING ROLES 

1. If Roles exist for a Fact, they do not have to be used 

2. You can assign a person not in your database to a Role 

3. When you add a new Role to a Fact Type, you should stop and ask yourself: 

a. Do you need to modify the Sentence Template for the Principal Role, or any other Role 

Sentence Templates for this Fact Type to include the people that get assigned to this new 

Role? 

b. Are there people already in your database that you want to go back and decide whether this 

new Shared Fact Role is applicable in their same Fact. If yes, you might want to make a 

Group of everyone currently in your database with this Fact Type to use as a TODO list of 
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people to check either now or in the future. If you choose to wait until later, you might want 

to create a Task describing what needs to be done to refresh your memory when you are 

ready to proceed 

CUSTOMIZING SENTENCES 

1. If you use the “Customize Sentence” function on a person’s Edit Person window for a specific 

Fact, be aware that currently there is no way in RootMagic to locate them in the future other 

than opening each Fact assigned the Fact Type in question and comparing its Fact Sentence with 

the default Fact Type Sentence Template 

2. If you delete the Fact’s Sentence Template, you will get the same result as if you had clicked on 

the “Reset To Default” button. The default Fact Type Sentence Template will be inserted 

3. Things to consider before customizing a Fact Type Sentence Template: 

a. Is the change you’re considering just a one-off situation, or only applicable to a few people? 

If yes: 

i. Just customize that specific Fact Sentence Template  

ii. Copy/paste the revised sentence format to the few other people it applies to 

iii. If you want to locate these customized Fact sentences in the future, consider making a 

list of who and which Facts you modified in a separate log file, or tag each modified Fact 

with a common Task 

b. Is this change something you’ll want to apply to several people’s Facts? If yes: 

i. Consider the possibility of modifying the Fact Type Sentence Template using the 

Sentence Template Language 

ii. Or, create a similar, but different, Custom Fact Type allowing you to select one or the 

other depending on which Sentence Template is more appropriate for the Fact you are 

entering. As long as it’s not a “Special” Fact Type. 

c. If the customization involves people the Fact is being shared with, you should ask yourself 

whether the changes should appear in the Sentence Template for the Principal, a particular 

Role, both or maybe you need to create a new Supporting Role for this unique situation 

d. When customizing a Sentence Template for a Fact that has been Shared with the Person, be 

aware that the resulting sentence in the lower portion of the window will only include 

[Person], if used. [Date], [Desc], [PlaceDetails] and [Place] from the Principal’s Fact will not 

be shown. To see the complete resulting sentence, you must click OK and view it in the 

“Sentence” area on the Edit Person window. 

SENTENCE TEMPLATE LANGUAGE 

1. Reminder: Modified Sentence Templates for built-in Fact Types must be manually transferred to 

other RootsMagic database files you want to use them in. Neither the Drag & Drop, nor 

Importing Fact Type List functions will modify the sentence templates of built-in Fact Types in 

the destination file. 

2. The Online Help for this topic covers all the Template Language Data Field Names, Field Options, 

Formatting Codes and Switches that can be used along with some examples of their use: 

https://help.rootsmagic.com/RM10/sentence-template-language.html  
a. The Online Help incorrectly states that the Private Switch can be used for Fact Sentence 

Templates. Actually, it can only be used with Source Templates. 

https://help.rootsmagic.com/RM10/sentence-template-language.html
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3. Blank lines can be inserted in a Sentence Template by adding Carriage Returns where blank lines 

are desired 

4. A 9-step approach to crafting a Sentence Template: 

a. When you are planning to create, or modify multiple templates for a Fact Type, you may 

find it easier to focus on developing 1 at a time, starting with the Principal Role and then 

moving to any Supporting Roles desired. This will allow you to focus on a single goal and 

leverage any common elements in subsequent iterations to develop the other templates 

b. Examples using this 9-step approach can be accessed here:  

https://gfo.org/file_download/inline/cd4aa506-b997-444a-907d-9fcef436cefb  

Step 1: Draft a sample of how you want the resulting sentence to read 

Step 2: Replace the pieces of the sentence where the specific information will come from 

one of the Fact Data Fields 

Step 3: Confirm the needed Optional Data Fields are active for this Fact Type 

Step 4: Determine if there are additional people and/or Supporting Role names that need to 

be included in the sentence. 

i. If the only other person is the Principal’s Spouse, then the Custom Fact Type 

should be created as a Family Fact Type. Or, create as an Individual Fact Type, 

with a Supporting Role to share with the Spouse. 

ii. If other people are to be included, the Supporting Roles must be created so they 

can be assigned to these people and included in the sentence 

1. Reminder: There are a variety of Field Names when referring to people 

other than the Principal Person and sometimes they are different when 

referring to them in the Principal sentence vs a Supporting Role sentence. 

They are listed in the Online Help  

2. Note: People that are assigned Supporting Roles and included in a Principal 

Sentence Template will be included in the Narrative Report Index that 

include the Principal, even if the report does not include the Supporting 

Person 

iii. For each Supporting Role created, this 9-step process should be repeated to 

craft each corresponding Supporting Role Sentence Template 

Step 5: Evaluate the default verbiage that RootsMagic automatically adds to determine 

whether some Field Options need to be specified to get the desired result. 

Step 6: Determine whether, and where, conditional brackets are needed to address 

situations when one or more of the specified Data Fields are blank 

Step 7: Decide whether any Switches are needed due to different verbiage needed 

depending on a Value, Gender, Number of People or whether the person is Living or not 

Step 8: Decide whether any text formatting is desired (Bold, Italics, All Caps, etc) 

Step 9: Trial & error testing: 
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i. Remember that “trial & error” is part of the process of crafting the Sentence 

Template that you want, as long as what you want isn’t more sophisticated than 

what the Sentence Template Language supports 

ii. Since RootsMagic processes the template left to right, when issues are 

encountered, you should also work left to right through the template to identify 

& correct them.  

c. If there are additional Sentence Templates to develop for the Fact Type, repeat the 9-step 

process for each one 

d. Once all templates have been developed and tested, they need to be inserted into the Fact 

Type as the default Sentence Templates for their respective Roles 

e. Lastly, ensure that the People’s Facts that were being used for template development & 

testing by Customizing their specific Sentences have their Customized Sentence Templates 

“Reset to Default” by either clicking on the button, or deleting the entire contents of the 

Sentence Template area 

SHARING FACTS 

1. The quandary (Pros & Cons) between using/not using Shared Facts: 

a. https://sqlitetoolsforrootsmagic.com/facts-split-shared-to-

individual/?fbclid=IwAR30EqpKaHAB_5uLkme3vqB6F-

NLxjxUqaCgxwdO0g5OqL7xq5Hr7HDNZ9I   
b. Use Shared Facts, but don’t plan on: 

i. Exporting Shared Fact information to other sites and software, many of these other 

locations cannot extract the Shared Fact information contained in a RootsMagic 

generated GEDCOM file 

ii. RootsMagic cannot pass Shared Facts to Ancestry (via TreeShare) or FamilySearch 

iii. Being able to manage them like Facts, since you cannot search for them or create 

reports that include them other than Narrative reports and export to a Website 

c. Don’t use Shared Facts when wanting to: 

i. Preserve maximum flexibility in exporting data to other sites and software 

ii. Manage them the same as all other Facts 

d. Use external 3rd party tools to manipulate either a RootsMagic database file or GEDCOM 

export file to try and convert Shared Facts to Individual Facts 

2. When viewing a Shared Fact in the Person that it has been shared with: 

a. The information displayed in the Edit Person window’s list of Facts is the information that 

applies to the Principal Person, not the Person assigned the Supporting Role 

i. If you edit any of this data, you will change the information for the Principal Person, not 

the Person assigned the Supporting Role 

b. To view the data applicable to the Person assigned the Supporting Role (Person, assigned 

Role and their Note), you must select the person from the list of people the Fact has been 

shared with 

3. The list of Supporting Roles presented to select from when Sharing a Fact is listed in the order 

they were created in RootsMagic. If you want to change which Supporting Role is listed first, you 

must: 

a. Create new Roles for each one currently listed above the one you want to be first  

https://sqlitetoolsforrootsmagic.com/facts-split-shared-to-individual/?fbclid=IwAR30EqpKaHAB_5uLkme3vqB6F-NLxjxUqaCgxwdO0g5OqL7xq5Hr7HDNZ9I
https://sqlitetoolsforrootsmagic.com/facts-split-shared-to-individual/?fbclid=IwAR30EqpKaHAB_5uLkme3vqB6F-NLxjxUqaCgxwdO0g5OqL7xq5Hr7HDNZ9I
https://sqlitetoolsforrootsmagic.com/facts-split-shared-to-individual/?fbclid=IwAR30EqpKaHAB_5uLkme3vqB6F-NLxjxUqaCgxwdO0g5OqL7xq5Hr7HDNZ9I
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b. Switching all affected people to the newly defined Role(s). You can do this by: 

i. If using RM9, make a Group of all people that have the Fact Type containing the affected 

Supporting Role(s) 

ii. If using RM10, make a Group of all people in the database that have the “Number of 

Shared Facts” > 0 

c. Filter the Index List to only show people in the Group you just created (if using RM8 or 9, 

step b.i; if using RM10, step b.ii.) 

d. Open each Person’s Edit Person window and check to see if the Fact Type being modified 

has been Shared, and if so, whether the Supporting Role that is being changed was Shared 

with them 

i. If it was Shared, change the assigned Role to the newly created one 

ii. If a Supporting Role Note was entered previously, it remains after changing the Role 

e. Once every Person has been checked, then you can delete the “old” Supporting Roles from 

the Fact Type which should result in the desired Supporting Role being at the top of the list  

f. NOTE: To avoid doing the above, as soon as you decide to Share Facts: 

i. You should spend time thinking through what your desired order of Roles to choose from 

should be and create the Supporting Roles in that order 

ii. If you don’t want the built-in Supporting Role (usually “Witness”) to be the default at the 

top, delete it and recreate it when desired 

4. When Sharing a Fact and assigning the same Supporting Role to more than one Person, when 

the names of people with this Supporting Role are all listed, they are listed in the order the 

Supporting Role was assigned to each Person 

a. When a Fact is Shared with multiple people at the same time, the order in which they will be 

listed is unpredictable 

5. When assigning a person not in your database a Supporting Role, remember that: 

a. You can only enter a Given name and Surname. Also, if you have SETTINGS > GENERAL 

SETTINGS > “Surname Uppercase” checkbox checked, RM DOES NOT capitalize the 

Surnames of these people that are not in the database 

b. If you enter a Role Note, it will never appear in a report since these people aren’t in the 

database, there won’t be a Narrative report entry for them, which would be the only 

location where the Note would be used 

6. If you want to switch an assigned Supporting Role from a person in the database to someone 

not in the database or vice versa, you cannot do it by editing the existing assignment. You must 

create a new Shared Fact entry 

7. When crafting Sentence Templates for Supporting Roles, remember: 

a. [Person] always refers to the Principal Person, even when working with a Family Fact 

b. [ThisPerson] refers to the person assigned to a Shared Supporting Role 

c. [OtherPersons] is everyone that is assigned to any of the Shared Supporting Roles 

d. [Role] where “Role” is the Supporting “RoleName” is: 

i. Everyone assigned to the specified Shared Role when used in the Principal template 

ii. Everyone assigned to the specified Shared Role, except the Person the Fact is Shared 

with. To include them, [ThisPerson] must also be included. 

e. [ThisPerson:Role] results in the Role Name being inserted in the sentence rather than 

ThisPerson’s name 
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f. [Field#] allows you to specify specific people’s names that have a Shared Role when more 

than one person has been assigned the same Supporting Role. Caution must be exercised 

when using this if you are trying to single out specific people in your template since the # is 

based on the order people are assigned the Supporting Role 

g. Only people assigned Supporting Roles that are mentioned in the Principal Sentence 

Templates are listed in the Narrative Report Name Index. This can be an import way to 

include important people that aren’t otherwise related to the family line the report is being 

generated for 



GFO RootsMagic SIG Handout 

Barry’s Recommendations/Online Help Supplement 

Page 37 of 43   7 July 2025 

ONLINE FEATURES 

MYROOTSMAGIC 

HTML WEBSITE 

ANCESTRY TREESHARE 

FAMILYSEARCH 

1. FamilySearch Person Tools 

a. Share Data With FamilySearch: 

i. In v10, when they exist, you can share a matched person’s FamilySearch “Brief Life 

History” with the person in your RootsMagic database file.  

1. When brought into your database, the information is placed in a “Life Sketch” Fact  

2. The 1st time a Life Sketch Fact is added to your database, a new, Custom Fact Type 

(Life Sketch) is added to the file’s list of Fact Types  

3. The information is placed in the Fact’s Description field 

a. Reminder, the Description field is recommended to contain no more than 100 

characters 
b. You may decide to move most, or all, the Life Sketch text to the Fact’s Note field. 

If you choose to do this to ensure no loss of data when exporting it, be aware 

that the FamilySearch Person Tool will show that the version in RootsMagic is 

different compared to the version at FamilySearch 

LDS FEATURES 

WEBTAGS 
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ENTERING INTERNATIONAL CHARACTERS 

EMOJIs 

1. Emojis are a unique character set that can be inserted like International Characters anywhere 

that text can be entered. However, they are treated differently in RootsMagic. Currently: 

a. Emojis do not appear in RootsMagic Charts and Reports 

b. Emojis can be transferred via TreeShare to an Ancestry tree 

c. Saved searches that include emojis do not work when re-used and RootsMagic Tech Support 

recommends not using them as a search filter.  

d. Tech Support reports that some emojis have been found to cause issues with some reports 

and may cause a GEDCOM export to fail 

2. It is recommended that you refrain from inserting emojis into a Person’s Given or Surname 

because they will affect the results received back from any WebHint or online site searches that 

include them. 

3. Your operating system Emoji keyboard can be activated by pressing Windows key+”.”(period) on 

Windows, or Ctrl+Cmd+Space on Mac computers. 

4. Another option is to find, copy & paste them in from an emoji website, such as: 
https://getemoji.com  

5. Once entered, they cannot be turned on/off for different activities. Therefore, careful 

consideration needs to be taken before deciding to add emojis into your database.  

a. If inserted in a Fact, inclusion of the Fact Type can be turned on/off by editing the “Include” 

settings for the Fact Type.  

b. If the “Reference No” Fact Type is used for emojis, they can be displayed after a person’s 

name in RootsMagic in place of the RIN (record identification number) or FSID (FamilySearch 

Identification) by changing the setting found at: 

i. Setting > General Settings > “Number To Display” to “REFN” 

  

https://getemoji.com/
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OTHER INFORMATION: 

Resolving known problems: 

1. If you are using a Mac and get the “Unexpected Error Instance of “TabuImage” not created” 

error message, some users think it is caused by the presence of unacceptable special characters 

in 1 or more media file names and/or folder paths. However, RootsMagic has not been able to 

confirm this is the “real” cause of the issue and therefore do not have a guaranteed fix yet. To 

see if special characters are causing your issue, the steps to try and recover are: 

a. Perform steps above to Force Quit RootsMagic 

b. Rename the database if it is set up to open automatically when RootsMagic is started 

c. Start RootsMagic 

d. Open the renamed database  

e. Make a backup in case you want to revert back 

f. Go to the Media Page 

g. Optional, you may want to create a Multimedia List report to track which files require 

modification 

h. Under More Options (3 dot icon), select Search and Replace 

i. Search the Multimedia Filenames in the database for the following special characters and 

replace them, one at a time: 

i. #, $, commas, double spaces, (, ), {, }, !, *, and any other unusual special character 

symbol, like a square box 

j. For each character found and replaced, perform the same to rename the Media files using 

FINDER to highlight all names under the MEDIA directory: 

i. Choose RENAME from the FINDER File menu 

ii. Repeat finding and replacing each special character found in the database. 

2. If you share a database file between Mac and Windows computers, you may experience a 

compatibility issue on initial use. Running the Test Integrity Database Tool reports errors. The 

problem can be rectified by running either the Rebuild Indexes or Compact Database Tool, all 

found on the TOOLS Page. 

Technical Information:  

1. User Settings File: 

a. RootsMagicUser.xml – Each time RootsMagic is closed, all program-level setting information 

is written to this file for use the next time RootsMagic is started. The information includes 

User set options, window sizes, screen divider bar position information and lists of recently 

used files & folders. If set to remember them, Ancestry and FamilySearch UserNames and 

Passwords are stored in encrypted form too. 

b. Location:  

i. On a Windows PC, the file is located in the “Users > "yourusername” >  AppData > 

Roaming > RootsMagic > Version 9” folder. Note that the AppData folder is hidden.  

ii. On a Mac, a search of the hard drive should locate this filename. 

c. This xml file can be viewed (but not edited) in any web browser.  
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d. If for some reason you desire to edit the data, you can open it in any text/word processor 

software. However, the file does not contain sufficient formatting information for these 

programs to present the information in an easy-to-read format. It is recommended to open 

the file in a web browser for easy reading and location of specific data to be changed and a 

word processor to search for and edit the desired text. 

e. At this time, the information stored in this file are the last settings of the various 

window/form locations and sizes, selected settings, recent files & folders, etc just prior to 

closing the program 

f. You can replicate all of your settings onto another computer by placing a copy of this file in 

the correct location prior to opening RootsMagic. 

Problem Solving Information: 

1. Learning how a feature or tool works:  

a. The first step to learning about any new tool is to play with it and your ideas for using it in a 

test database to make sure you understand how things work before you use it with your 

main research database. 

b. There are 2 different ways to approach creating test databases: 

i. Create a small database, you could even Drag & Drop a couple of generations of your 

main database into a new, empty, file. Use the small database to test and learn how a 

tool works, or doesn’t. 

1. File > Create a New RootsMagic File > Empty File 

ii. Or, just make a copy of your entire database that you give a new name that clearly 

identifies it as a test database. Using a copy of your main database to test and learn how 

your actual data will be affected: 

1. File > Tools > Copy 

2. Decide where to put it 

3. Give it a name that makes it clear what it is  

4. Save the file 

5. Make a Backup of the copied file so that you can use “File > Restore From Backup” 

to Restore it whenever you want to reset your test database while testing things  

c. Play with the tool and how it behaves using the test database first, confirming your 

understanding of how it works. In addition to the Online Help, you can find information 

about the existing features and new capabilities as they are released here: 

i. Links in the Help and Support Section on the software program’s Home Page 

ii. The RootsMagic Community, which is viewable by the public, even without an account. 

You only need an account if you want to post. You may also need one to keep track of 

which postings you have read and which are new. 

iii. At our monthly SIG meetings, Open Q&A and SIG email 

iv. If you’re a member of the Private RootsMagic Users Facebook Group, there’s always a 

lot of posts about new features recently added to the program and questions about how 

to do things 

2. Using the filter search criteria window to create Boolean Logic filters is one of the more 

powerful tools in RootsMagic in terms of being able to find People that meet a specific set of 

criteria for your task or problem. 
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a. But it can appear difficult to use if you try to write and apply a string of conditions all at 

once and are surprised the resulting list is not what you expected 

b. The effect of using both the AND & OR connectors in the same filter criteria can sometimes 

create unexpected results 

c. Understanding what the filter field criteria are actually looking at is important 

d. Working out the complicated filters incrementally as a series of simpler, shorter, filters is a 

good technique to avoid some frustration and will usually help point to where things may 

not work the way you were expecting them to 

3. Resolving “linking issues” – Linking issues typically appear in one or more of the following forms: 

duplicate People with same RIN (record ID number), children from same family not linked to the 

same Parental Couple,and/or known Spouses shown as “Unknown Spouse” in the Descendant 

View). 

a. Note: If you determine the original cause was due to data you brought into your RootsMagic 

file via the Ancestry TreeShare or FamilSearch tool, it is recommended you fix the issue at 

those sites and bring the changes into your file rather than fix it in RootsMagic and attempt 

to push the fix back to the online site that caused the original problem. 

b. You can analyze and correct most linking issues by performing the following steps in the 

order listed: 

i. Run the 4 Database Tools found on the Tools Page to ensure there are no internal 

database issues 

ii. If not already displayed, turn on the display of each person’s RIN: 

1. Settings Page > General Settings > Number to Display = RIN 

iii. If you see duplicate people, with different RINs, these are separate duplicate people in 

your database that should be Manually Merged and the merged information cleaned up 

1. People Page > Tools icon > Manual Merge 

iv. With your initial person of interest selected, switch to the Descendant View and set the 

number of generations to display to “2” 

1. Reminder: All relationship links are either Parents (a Couple) to a Child or Spouse 

to Spouse.  

v. Analyze each “family” defined in the database for this person. Determine which people 

are shown in incorrect “families.” Look for: 

1. If you see the same Couple listed more than once: 

a. Open the Person’s Edit window and look for multiple Marriage Facts for the 

same Couple.  

2. The same Child appearing under more than one Couple (Person and Unknown 

Spouse and/or Person and same Spouse) 

a. Cause: Child linked to more than 1 set of Parents 

b. Solution: Unlink incorrect Parents from Child 

3. Some Children listed under one Couple and other Children born to the same 

Parents listed under a different Couple 

a. Cause: Children were not linked to the same Couple 

b. Solution: Link all Children to the same Couple in database and Unlink them 

from the other sets of Parents (user preference whether to Link/Unlink or 

Unlink/Link). 
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4. Couples you did not expect to see, including having an Unknown Spouse and no 

Children 

a. Cause: Either incorrect Spouse link applied, or Child was linked and 

subsequently unlinked 

b. Solution: Unlink from Spouse 

vi. Once you have determined which person and relationship needs to be corrected, select 

one of the Parents and switch to the Family View to ensure both you and RootsMagic 

are focused on the same Family relationships before performing the appropriate 

solution. 

1. Link/Unlink relationships in this family as necessary.  

2. Remember: The Unlink Family Members choice can be used when you want to 

unlink all Children from the Parents and unlink the Parents from each other for 

the Family displayed in the Family View 

vii. Repeat, starting at step iv, until all bad links have been corrected and the Family is 

properly depicted in the Descendant View. 

1. Note: If you have a multi-generational issue, you will need to shift the Descendant 

View 1 generation up/down to analyze and correct bad links within that Family. 

Upgrading from prior versions of RootsMagic: 

1. Upgrading from RootsMagic v7 or earlier: 

a. Contact the GFO RootsMagic SIG facilitator for the most current recommendations 

2. Upgrading from RootsMagic v8 to v9 or 10: 

a. If you are transitioning from RootsMagic v8 to v9 or 10,  review the following before 

proceeding with the actual installation and conversion process: 

i. RootsMagic v9 or 10, installs on your computer as a different software program. When 

ready, you uninstall version 8 as a separate action 

ii. When you initially open a v8 database file, it is “converted” to be compatible with v9. 

Once a file is “converted”, it can no longer be opened using RootsMagic 8. If it is desired, 

you must make a copy of the v8 database file and rename it or place it in a different 

folder in order to keep a v8 file that can be used with RootsMagic 8. Otherwise, make a 

backup of your v8 file and edit the filename to indicate it was the last backup prior to 

converting to v9 or 10 

b. Install the RootsMagic program, but do not open any files yet 

c. Select the SETTINGS Page and at a minimum set the Data Folder Settings to point to where 

each type of data is located. Normally, these would be the same folder locations as your 

prior version of RootsMagic, with the possible exception of the Data Folder if you have 

decided to place your v9 or 10 database file in a different folder than your v8 file 

d. Now open the database file you intend on converting to use with v9 or 10 

e. If you have used Color Coding in your v8 file, it has been assigned “Color Code Set 1” in the 

“converted” v9 file. You should assign the Color Code a meaningful name and review the 

colors used and consider giving them labels where appropriate 

3. Upgrading from RootsMagic v9 to v10: 

a. If you are transitioning from RootsMagic v9 to v10, review the following before proceeding 

with the actual installation and conversion process: 
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i. RootsMagic v10 installs on your computer as a different software program. While 

installing v10, the installation program will recognize that you have an earlier version of 

RootsMagic installed and offer to uninstall it for you. This choice is up to you. In most 

cases, users have no intention of using both programs in the future and would choose to 

have the earlier version uninstalled. The recommended first steps are different 

depending on which option you intend on selecting when you install v10:   

1. If you plan on keeping v9 installed, you will want to make a copy of your v9 

database file(s) and assign them a different filename to clearly indicate they are 

intended for use with v10. If your v9 files are not labelled to clearly indicate they are 

intended to be used with v9, you may want to rename them as well at this time. You 

may also want to place your v9 and v10 files in separate Data folders, where neither 

folder is a sub-folder of the other 

2. If you don’t plan on keeping v9 installed, you should make a backup of your v9 file 

and add something to the filename so that you know it was the last backup before 

converting the database to v10.  

ii. When you initially open a pre-v10 database file in v10, it is “converted” to be 

compatible with the new v10 (internal database tables). Once a file is “converted”, it can 

no longer be opened using RootsMagic a prior version of RootsMagic 

iii. If you are not confident that you won’t “accidentally” open the v9 file in V10, you should 

consider placing either or both different version database files in different folder 

locations, where neither file type is in a sub-folder of the other file type. 

b. Install the RootsMagic v10 program, but do not open any files yet 

c. Select the SETTINGS Page and at a minimum set the Data Folder Settings to point to where 

each type of data is located. Normally, these would be the same folder locations as your 

prior version of RootsMagic, with the possible exception of the Data Folder if you have 

decided to place your v9 or 10 database files in a different folder than your prior version. 

d. Now open the database file you intend on converting to use with v10 


